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Logical Reasoning

| by Rita’s grades in four tests are 82, 80, 76 and
70. What grade must she get on the fifth test
to raise her average to 80 ? \

(@) 86
(b) 88
(c) 92
(d 96

2 My mother is twice as old as my brother. |
am' five years younger than my brother but
three years older than my sister. I[f my sister
is twelve years of age, how old is my mother ?

(a) 24
(b) 30
(c) 40
()50 :
3; In the following series, find the wrong
element : :
17, 36, 53, 68, 83, 92
(a) 68
(b) 36
(c) 83
d 92
4. Choose the alternative which closely

resembles the mirror image of the given
combination. ;

ANS43Q12

(@ AURHEOLS
(b) SroesreuA
() 2HAEMDST
(d rsoscaAne

)3 Choose the figure which is different from

e

:
M @ 6 @

@ 1
(b) 2
{6) ' 3
(0 4

(Q6-10) Five roommates Rohan, Saleem, Tanmay,
Umesh, and Vikas each do only one housekeeping
task: mopping, sweeping, laundry, vacuuming, or
dusting ; And only one day a week, Monday through
Friday. :
(i). ~ Vikas does not vacuum and does not
. do his task on Tuesday.
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(i)  Saleem does the dusting, and does
. not do it on Monday or Friday.
(iii) The mopping is done on Thursday.
(iv) Tanmay does his task, which is not
vacuuming, on Wednesday.
(v)  The laundry is done on Friday, and
not by Umesh.
(vi) Rohan does his task on Monday
6. What task does Tanmay do on Wednesday ?
(a)  vacuuming
(b)  dusting
(c¢)  mopping
(d) sweeping
1. What day does Umesh do his task ?
(a). Monday
(b) - Tuesday
(c¢)  Wednesday
(d) Thursday
8. What task does Vikas do ?
(a) ~ Vacuuming
(b)  Mopping 4
(¢) Sweeping
-(d) Laundry
9.  What day is the vacuuming done ?
(a) Fridayh :
(b)  Monday
(¢)  Tuesday
(d)  Wednesday
10. When does Saleem do the dusting ?
(a) Friday :
(b) - Monday
(c¢) Tuesday
(d)  Wednesday
11.  Five poles are fixed in a row. M is on the
left of N, O is on the right of P which is on
the right of N. If L is on the left of M, which
pole is in the Centre ?
S
(b) M-
(¢c) N
(@) ®
ND - 2D/34
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10.

11.

(i) Q@ qge @Rl QIF ARS Ne° 6N
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(iii) - QIR ¥R QTR QA QAUIAN |
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(a) QuIQYF°
(b) Y& «@al
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(a) 6N
(b) QTR
(c) QU
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(a) @uIQude
(b) . sai@e
(c) <Ig ARSI >
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QUIQYF° 699 I@ QAUAN ?
(a) ¢8R
(b) eQRIQ
(c) QTRAQ
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" (a) g9
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(c) TRAN
d) QU
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‘M’ @ Qe AIGea 2T, 6069 ANYT AZER
6Q0 ¢9 28 ?

(@ L
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12. If in a clock, time is 9:30, then what time
will be in its reflection in a mirror kept in

front of it ?
(a)« 1330
() 1230
(c)¥ 9:30
d 615

From the options given below, in which
option, words are arranged according to the
alphabetical rule found in dictionary ?

1. Church 2. Chance 3. Celebrity
4. Cataract 5. Cement

(@) 453,21
(b) 43,52,
(c) 4325,1
(d) 4,235,1

(Q. 14-17) The following questions are
accompanied by three statements 1,2 and 3. You
have to determine which statement (s) is/ are
sufficient/necessary to answer the questions.

14. Find three positive consecutive even
numbers :

1. The average of four consecutive
even number starting from the last
of the given numbers is 17.

2. The difference of the highest and
the lowest number is 4.

3. The sum of the squares of the
three numbers is 440.

13.

(a) 1 alone is sufficient
(b) 1 .and 2 are sufficient
(c¢) 3 is sufficient
(d) . Either 1 or 3 is sufficient
15.  Rohit got 700 marks in the examination. To
find out his percentage of marks which of
the following information is/are necessary/
sufficient .
1. He appeared in all the nine papers.
2. The highest marks obtained is 90.
3. The maximum marks for each
paper is 100.
(@) Only 1 is sufficient
(b) Only 3 is sufficient
(c) Only 1 and 2 together are sufficient
(d) Only 1 and 3 together are sufficient
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16.  To find the length of the carpet which covers
the floor of a rectangular hall, which of the
following information is needed ?

1. The length of the hall is 28m.

2. The width of the carpet is 2.5 m.

3. The area of the hall is 490 Sq.m.
(a) Only 1 and 2 together are sufficient
(b) Only 2 and 3 together are sufficient
(c) Only I and 3 together are sufficient
(d) Any two statements are sufficient

17. What is the relative speed of two trains
runnmg in opposite directions ?

1. They take 15 seconds to cross
each other.

2. The speed of one of the trains is
60 Kmph.

3. The total length of the trains is
360 m.

(a) . Only I and 2 together are sufficient
(b) Only 2 and 3 together are sufficient
«(c) Only 1 and 3 together are sufficient
(d) Any two statements together are

necessary

18. Identify the figure that completes the pattern. :

1

) M @ 3 @
(@ 1
(b) 2
() 3
(@ 4

19. Look at this series :

Vv, VIII, XI, XIV, _ , XX
What number should fill the blank ?
(@ IX
(b) XXIII
(c) XV
(d) XVII

20. Which word does NOT belong with the

others ?
(@) inch
(b) ounce
(c) centimeter
(d) yard
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17.
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19.
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Choose the set of figures which follows the 21.

given rule.

* Rule: Closed figures losing their sides and open
figures gaining their sides.

@ QN E
@

2)

®,
AR

RAR

“)

(a)
(b)
(c)
d 4

Computer and Internet Awareness

2L A
window so that multiple web documents can
"R be displayed simultaneously.
4 (@) Frame
fl (b) set -

it
3 )
b

# ) (¢)  Frameset
x (d) div
{’ 23 8 controls all the main slide 23
) control tasks for your presentation in MS
PowerPoint.
3 (a) Task Pane
(b) Task Bar
(c) Control Panel
(d)  None of these
24.  What is the maximum number of columns 24.
that can be inserted in MS Word ?
(@)= 155
(b) 65
{¢) 50
(d) 45
25.  InMS Window Help window can be opened 25.
by ?
(a)- .2 ;
(b) F9
: (c) iRl
(d) Fl1
ND - 2D/34 (6)
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66. What is the shortcut key for “Find and
Replace” dialog box In MS WORD ?
) Gl H
(b) Ctrl + Shift + F
(e) . Ctrl + R
(d) = Ctrl +F

27.  What shortcut key is used to split a table in
MS Word ?
(a)  Ctrl + Shift + Enter
(b)  Alt+ Space + Enter
(¢c) Ctrl + Alt + Enter
(d)  Alt+ Shift + Enter

28. What PowerPoint feature will you use to
apply motion effects to different objects of
aslide ?
(a)  Slide Transition
(b)  Slide Design
(c)  Animation Objects
(d)  Animation Scheme

29. In MS Excel Long text can be broken down
into many lines within a cell. You can do
this through :
(a)  Wrap Text in Format > Cells
(b)  Justify in Edit > Cells
(c¢)  Text Wrapping in Format > Cells
(d) Allofabove

30.  Crl + D shorteut key in Excel will :
(a)  Open the font dialog box
(b)  Apply double underline for the active

cell ‘
(¢) Fill down in the selecﬁon
(d) None of above
~31.  Which menu option can be used to split

windows into two in Excel ?
(a)  Review > Window
(b)  View > Window > Split
(c) Window > Split '
(d) View> Split
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1.

28.

29.

30.

3l

Qe Q. Q1668 “TIag 21g AsgQ” SINRE,
99 JIQ AGRE @1 @€ ?

(a) Ctl+H
(b) Ctrl + Shift + F
(c) Ctl+R
(d Ctl+F

U6l N9, GIF6R ¥R 669R IRRe QAP
69 49RE Q1 NILIQ FAUAN ?

(a) Ctrl + Shift + Enter
(b) - Alt+ Space + Enter
(c) Ctrl +Alt + Enter
(d) Alt+ Shift + Enter
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d udeqag e

6. IQ I6TRER AU 66 IR 6QIT FRIER
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('Turn over)



JOBPORTALPOINTS.COM

32.  Which tool do you use to create a query
object in MS-ACCESS ?
(a)  Database wizard
(b) Simple filter wizard
(¢) Simple query wizard
(d) Table query wizard
33. The process of divisidn of memory spaces
is called
(a) Paging
(b)  Segmentation
(c) Bifurcation
(d)  Dynamic Division
34. ' OSI stands for
(a) Open System Interconnection
(b)  Operating System Interface
(c¢)  Optical Service Implementation
(d) Open Service Internet
35 HTTP s . protocol.
(a) application layer
(b) transport layer
(c) network layer
(d) datalink layer
36. Datacommunication system within a building
or-campus is
(@) LAN
(b) WAN
(c) MAN
(d) PAN
37. A ________ is a device that forwards
packets between networks by processing the .
routing information included in the packet.
(a) . bridge 4
(b)  firewall
(¢) router
(d) hub
ND - 2D/34
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34.
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37
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38.

38,

40.

41.
code ?
(a 16
() 0
() 2
d) 4

42. is the functional key to display
save-as box.
i
(b)  Fé
(c) F9
(@ . Fl12

: Current Affairs

43, Who has written the book “The Light We
Carry” ? '
(a) Barack Obama
(b)  Michelle Obama
(¢)  Sashi Tharoor
(d)  Amitabh Ghosh

44. Who is Mohamed Irfaan Ali ?
(a) President of Guyana
(b)  Prime Minister of Lebanon
(c)  Foreign Minister of Turkey
(d) Home Minister of Malaysia

ND — 2D/34

The “S” in HTTPS stands for :
(a) Selected

(D) . Secure

(¢) Software
(d) System

What will happen if the email does not contain

the subject while sending ?

(a) ~ Mail will not be sent

(b)  Mail will be sent normally

(c) Prompt asking to send mail without

subject :
(d) None of these
In MODEMS :

(a) several digitél signals are multiplexed

(b) a digital signal changes some
characteristic of a carrier wave

(c) digital signal is amplified
(d) Allofthese

How many bits are there in hexadecimal

38.

39.

40.

41.

42,

43.

44,

HTTPS 6 “S” @ 2¢l 6208 ?

(a) Qeneqe
(b) QeauQ
(©) QgsER
(d <aq

I Q0IRQI AAAER QAEFINER YT FeUIN 666D
@6 629 ?
(a) 6FQ 6904 629 QIE

(b)) 69R QRIS QIS 6TQE 629
(c) 99l 906R 661Q TOIRRI RIS AR

Q@ gAE 6QEIERR
(d) @68 6EdT gee
6ElIEREER :

(a) 26eaR @301 ATRIR AREHST 62108

(b) <e G861 AR 98 QLR CATR
@8 c38ay afeae Q6a

(c) CFCIR ARG UNRTIR AU

d) @8Nl

62916037 6QIYER 660 I6 &R ?

(@ ¢

® o

&) % ;
d ¥

“6AR-2IR” 9F JAEIe FARIP 699 “TFARIR
Q1" QIQRIQ QR ? -

(@) F5
(b) Fé
(c) F9
(d Fi2

Agde acdiea
“@ AIRC § QUA” gee Qv 6Ad8s ?
(a) QIR B
(b) Gesm B
(c) <a12QR
(d) afcIQ eals
A9RQ Qdie 2RI @9 ?
(a) 9LIfIR AT
(b) 6RIRIFR PURFR!
(c) 991668 Al
d) cIeadzia geaar
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45.  Which district got “Best District Panchayat
Award” under National Panchayat Award
2023 2
(a) Cuttack
(b)  Murshidabad
(c) Ganjam
(d)  Hyderabad
46. Odisha FC won Hero Super Cup ih April
2023. Which team did they defeat in final ?
(a) Bengalurh EC
(b)  North East United
(¢) Jamshedpur FC
(d) - Kerala Blasters
47. In which field has D.amayanti Beshra
* distinguished hersélf ?
(a)  Odishi Dance
(b)  Santhali literature
(¢) Odialiterature
(d) Classical music
. 48. President of Taiwan recently visited USA,
; | thereby upsetting China. What is the name
of Taiwan President ?
(a) Tsaing-wen
: (b) MaYing-Jeou
(c)  Chen Shui-Ban
(dykee Teng-Hui
49.  Who was conferred Sahitya Akademi Award
' for Santhali Literature for 2022 ?
(a) Shyam Sﬁndar-Besra
(b) Kali Charan Hembram
(¢) Niranjan Hansdah
‘ (d)  Kajli Soren (Jagannath Soren)
ND - 2D/34
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(a) eeegeugd -
(b) e IRIRCTR
(c) eSIeaege 9 &
d eqae qad
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(c) Fowe Lal

- (d) QR 66 (RORIE 6QI6RR)

Contd.
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Birthday of Netaji Subhash Chandra Bose is 50.

observed as Parakram Diwas. His Birth day

- fallson:

(a) 2lstJan
(b)  25th Jan
(c) 19th Jan
(d) 23rd Jan

As per data released by SIPRI in April 2023, S

what is the rank of India among countries

" of world in military spending ?

th

(@ 6
®) th
© Sm
) sth
Who was sworn in as President of D25

' Bangladesh in April 2023 ?

(a) Mohamad Shahabuddin Chhupu
(b)  Shirin Sharmin Chaudhary

(¢) Mohamad Abdul Hamid

(d) Zilur Rehman

Recently 50 years of “basic structure 33

doctrine” by Supreme Court was celebrated /
observed. In which case was this doctrine

laid down 50 years ago ?

(a) Keshavananda Bharati case
(b)  Golaknath case

(¢) Minerva Mills case

(d) Menaka Gandhi case

Where was country’s first water metro - 54,

inaugurated recently ?

(@) Kochi
(b) . Prayagraj
(c) Delhi

@ - Kolkata

ND-2D/34 (11)

6R0IF1 QRIS R 6QES PRARY TAURS
Aed QUNER PR AN | SITR OF @
6Q69 ?

@) 9¢ QU
®) 98 QA1
©) °¢ QIgEIat
@ 97 SIgEQ1

9@ 909Meq SIPRI QIR GRIFS Q2

AQRAIS, AFRR YFER IGQ QAR FRIER

QAR He @6l ?

(a) <9

(b) ogd
(c) <Ea
d zeq

IR 9097 6Q AAIELER AIFUT AR
@4 g2 g8 Qfgem ?

(a) ©29Q SIRIPER 89

(b) &8q afiq eTlya

(c) €27 2egm 28Q

d) &g eaenle

fec6a 90 69I9E Qal ‘6adQ 89Q O]1R]
Q 8o QEQ AIRR/AQAUR LAIAIQAURNI |

g0 Q¥ g6@ 6@ AIARIca 1@ RIS
QHIQIREARI ? :

(a) 69N VRS Fllciml

" (b) - 6QIRRRIY AIAR

(c) Feqqal g Alawl

(d) 60991 GIf AIARl

FRT6R 629R GAA QISR 671681’ 6RLV0IER

QQAITO 6cARAMI«?

(a) 6RI
®) gaeale
© o8
d) 6RRRIQ!
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55.  Shri Prakash Singh Badal died on 25t April
after a distinguished career in politics. How
many times was he Chief Minister of
Punjab ?

(@ Twice
(b) Thrice
(¢) 4times
(d) 5times

56.  Which among the following countries is not
a Member of QUAD ?

(a USA.
(b) India
(c) Japan
(d)  South Korea

57.  Sportsmen of which among the following
discipline are on protest at Jantar Mantar in
April 2023 alleging sexual harassment and
corruption in their federation ?

(a) Wrestlving

(b)  Weight lifting
(¢) Gymnastics
(d) Swimming

580 14" ICC men’s Cricket World Cup (ODI) is
scheduled to be held in Oct-Nov 2023 in :
(a) England
(b) Australia_

(¢) India
(d)  South Africa

59.  Per capita jncome growth between 2011-12
to 2022-23 for India (CAGR) was 9.4%.
During same period what was per capita
income growth in Odisha ?

(@ 9%

b) 9.5%

() 10%

(d 10.5%
ND — 2D/34

03

56.

Y0

58.

59,

(12)

g1 gele 3@ QR ALRFa QNSRS
98 @8l g6a vdn 98 edgea fe4eQel
QPALER | 69 UBINR 6960 &Q gsuaan
26R ? '

(a) geea |

(b) TR
(c) o1& aa
@ asea

faade auq cad caa ‘e’ @ geqy
Q62 ?

(a) eade
b «ee
(©) e

d <ofa ezl

FaRde aug e Salgq QIPIFQAIER
6AAIPE Qa6R 6dle Rdienl e ga1e
UREAIS 2IE IFR 90 9N6R PVAFBROIER

9691 @gad ?
(& o8

(b) SeRIeRIRG
(OR [0

(d) <eqe

USYR-FENAQ 90 9INER, MO AT
299 Geac Aqea (FRGe) sadoisa 2igie
629 ?

(a) on¢

(b) aeqRel

(c) e

d) ofeagel

JoRe-09 @ 9099-9M rIEA RIGEQ
qedel g 2898 (IdaR) ¢.¥% gl |
@ Qg Auea BRaIca qadel aig AQQR
6Q6Q gl ? :

(@) %

(b) c.8%
() eo%
(d eo.8%

(Turn over)
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60.  During 2021-22 Indian Economy‘s growth

rate was estimated at 8.7%. What was the
growth rate of Odisha Economy during the
same period ?

(@) 8.5%
(b))  9.5%
(c) 10.5%
@) * 11.5%

Data Interpretation

(Q61-64) Study the following bar chart carefully
and answer the questions given below it.

Crude oil availability. (India) (In million tonne)

20

13.
15 3.93

14.1

14

10
5

0
1988-89 198990 1990-91 1991-92 1992-93
M Production B Imports

60.  909€-99 6a VUAGIA UIFER ARFE 2IQ
F.9% Q29 69 2R LAUAMAR | 638
QFG6R B34 LERTOR ARIE 2AQ 6960 &M ?

(8). 8%
b)) 8%
(c) eo.8%
(d) " eeex
@Y YIgI

(Q 61-64) TS QIR SIS AIRUIFIR AL 2IOR
20 IQ° I2AQ FEQ TN gFIFR Qe
Qag | ‘
g6l e 66@ vaneel (a1ee) (fge
eqea)

ey eq. ¢ fY¥.¢ ¥.¥ es

o -
QCIT-I¢ eUTC-C'o @CCo-CReCCR-CY UEI-aq

M eqiee B aiaei

61. Crude oil production (in million tonnes)
during the year 1991-92 was :

(@) 144
® 107
() 14.1
@ 89

62.  What was the difference in crude oil imports
during 1990-91 and 1991-92 (In million

tonnes) ?
(@ 0.3
(®) 0.2
@) 0l

(d)  No difference

63. In which year, was the crude oil production
roughly 80% of the imports ?

(@ 1989-90
()  1990-91
(c) 199192
(d) 1992-93

64. As compared to imports, what was the
percentage of crude oil production during

1988-89 ? :
(@ 45%
(b) 50%
(€) 55%
d 60%

ND = 2D/34 L (13)

61. ecce-¢9 AdRIER ACHIG 6090 QQIRR
- - (990 6968 6260 62RUMI ?

(@  exy
() €09
(c) ex.e
d r.¢

62. RUCO-CR NQ° RACR-CY CRIER ACHIYS
66n8 2UIFAN A HRUIR 6760 (FYO F76R) 7

(@ om
(b) o.9
&) oR

(d) 66 QP 918

63. 6QQ QU6R Y6AING 8RR AYITR, ZIAQIRT
@RRIER GID 0% 629 ?

(@) eere-co
(b) ecco-¢e
() ecce-¢9
(d ece9-em

64. AFAN GIAIER, € M-I ¢ 6Q ACHIG 609
Q QAR F0RF! 660 2RI ?

@ ¥&%
(b) 8o%
c) %8%
d) 0%

Contd.
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(Q65-59) Study the following table carefully and
answer the questions given below it.

Sugarcane production by six major states during
1986 to 1990 (in million tonnes)

(Q 65-59) FREIC Aladp ANRIGIIR AL BIAR 0P
NE° 2R BY6R QIR JEIERR Qan Feg |
eCr Q €0 AUER HF gee QU QI g

g9 (Fge og6a)

Year / |
States P Q R S T X |TOTAL
986 | 140 65 | 438 38 391 0. 362
987 | 132 63 62 56 | 40| 23] 376
988 1 150 | 55 | 72 49 36 | 271 389
1989 | 168 60 | 45 65 | 431 25| 406
1990 | 170 | 45 | 70 62 | 42| 23| 412

65. Which of the .following States shows a
constant fall in sugarcane production every

year ?

(@ P
® Q
() R

(d)  None of these

66. In which year during the given period was
the percentage of state Q’s share the highest
in the total production ?

(@) 1986
(b) 1987
(c) 1988
(@ 1989

67. In which year does state ‘P’ have a share of
about 35% in the total sugarcane production ?

(@) 1986
(b) 1987
(c) 1988
(d 1989

68. In the year 1990, how many of the given
states have a share of 15% or more in the
! total sugarcane production ?

(@) Three
(b) Four
(¢) Five
(d Al

~

69. What was the extent of increase in sugarcane
production in state ‘S’ from 1987 to 1990 ?

(a) 6 million tonnes
)7 million‘tonnes ‘
(c) 10 million tonnes
(d) 12 million tonnes

ND - 2D/34 )

Sle |l ol rR]| s| 1] xleqges
Crole¥o | 98 | ¥ NC_| e f 99] M89
Rerofem9 | on | 99 89 | ¥o | 9N M9
RCIr|R8o | 88 | 99 ¢ | M9 | 99| qre
Rerdjear | o | ¥8 8 | ¥N| 98] ¥o0I
RCCofR90 | ¥& | 90 D9 | ¥9 | 9N| ¥e9
65. QAGe AUQ 698 QIRYER gied 2ig

RAYILFER FAIGS 2T CQUIAI ?

(@ P
(b) Q
(c). R

(d) Qo6 6adT geL

6.

67.

68.

69.

IR T FRIER 696 9F, 67116 AYIRER
QIR Q" Q S0QQ! QIS AR 2T 7

(& edrs

b) eers
(€) - eerT
(d ecrc

600 Qd, agalg UY AYIQREQ AN P’ Q
UG N8% &8 ?

(@ eers
(b) eero
(¢) . “Rerr
d ecrc

RCCo AdRI6R, 6716 2Ig AYIRER,
UAINYR! QAURIYFR FRIQ 6Q6S6HIT AR
QUG 8% @ 9 Ol 2L ?

(@) Oeal@
(b) <&
(c) «<Ed
(d aag

RCM9-RCCo AR QIRY ‘S’ 6Q 2l
RUIXFER 6Q60 98 6RIRAT ?

(@) 98ge6eQ

(b) odgeeq
() eoFgeeq
d ¢9 3ge eg

(Turnover)
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(Q70-71) Study the following bar diagram carefully
and answer the questions given below it.

" (Q 70-71) GYAGGe ‘Qa §g’p ARILSIQ_AL
AUDR QAP NQ° NRIQ AEJ6Q QURIRRLS 9GIFRR

{ Loss due to strike of Textile workers in Qe @ug | & X e
| Mumbai (Rupees in Crore). QERER QAR JreE uAAS 6alg A%
| (6QIF oI6Q) |
1 200
1 3
i 155 900
| 150 : e88
115 110 ego— i
100 B ees eeo
| : : Qoo
) 50
‘ 80
] ‘Production Export Wages ° QIQQ L
i Qgla gl
‘ ---—-—Loss due to-—-----— o » ¥
YRR el T e e—. R Sl T ——
70.  The ratio of losses due to production in T G 2
: proportion to losses due to wages is 70. QAR 990 96 ¥e° AFQT 6QIg 62IR
approximately equal to : [EQ AFAIS GIol 6966 ?
(@ 2:11 (@ 9:¢e
(b) 11:2 ' (b) ee:9
() =k ‘ () 9:8
(@ .74 : d 9:%
71. During the strike, the ratio of the loss in 71.  Ndae gagea QgIG 900 96 9e° Qg

export in proportion to loss in production

o P60 A6 FUER UPAIE 6R60 ?

(@) 23:31 : (@ 9m:me
(b)) 45 : b) ¥:8
(e)-i13¢5 () ai:8
@ 12:11 : B G

~ o

(Q 72-74) AATFO AIRE16Q 90T TMIRA A ¥9° B

o~ s

(Q72-74) In the following table, results of two " il
QA IRNTR QUILIAR | L QI ZIMIQER, QMG

schools A and B are given. On the basis of this

table, answer the following questions. -9490ea eaa dag |
School A School B QQUIRG A UIea B
Class | Appeared | Passed | Appeared | Passed |egen | adal | aiq | ada aiq
in the exam in the exam __|eeyen [ce1ead| cengen se10ed
X1 140 136 % <110 i Qe | exwo eM8 | :eRo ??
Xl .| 160 150 N 105 Qs €90 e8o %1 Ro8
X i 160 110 80 Qaa | 779 €90 | eeo ro
IX 130 N 90 340 ! Mo 9.0 ¢o any o
TOTAL 630 550 430 340 Q?l@la Mo 880 ¥Mo qNY o
72.  What percentage of students passed in both 72. 909 IMIRLER AFQIC 6960 OGO SIgRIgT
' the schools ? . aiq /ed ?
(a) 80.0 : (@ ro.0
(b) 839 (b) ra.c
(c) 874 : {0) BN
@ 900 - e @ topo
ND - 2D/34 {10 Contd.
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3:

74.

The total number of students who have
passed in class X in the two schools, is :

(@) 310

(b) 255
(c) 240
‘) 155

The average of the students who have passed
in classes IX and X from school ‘A’ s :

(@ 700

() 1325
(c) 1425
(d) 155.0

(Q75-78) Study the data given below and answer
the following questions.

. 500 delegates in an international meet were

handed over cards like the following :

English EL]
French F L1
German S |
Asiatic Language AL

They were asked to tick the names of the
languages in which they had sufficient skills.
Then the cards were collected and sorted
into piles with the following numbers of
cards in each plle

48,

296 IMIRAR Qae 694116Q QI @AY
AU QIQRIQTE A°HY| 6Q6Q ?

(a) qeo
(b) 988
() 9%o
(d) ess

AMIRa ‘A’ Q 996 6 QaF 6gaTeR AIQ
RAEQI 2QILA VIGRIGTT I 6R6O 7

@ 0.0

b) em9.8
(c) e¥9.8
(d es8.o0

(Q 75-78) Gj6a QuIIRAR Gel LGS Aag 19
Gonde g99een an Gog |

9 esielg QﬂQQIGQ &oo0 geeu_g
faade «f QUG geie @alaiial |

QAR E[
(3¢ e o
edie : G[J
Q1Y QU A

696 QIBICA 6AFIPTR U621 ATG! 628 SIRIR
QIe1 §Q @AQIQ FRAAIRR | GIT6Q 91@61@@
YL @GRl I FIRTS A6R IS aIgaIL
J98 @ ARG LGl G9I6a QiaRl |

: aQIgin "

Languagey E | G| A |EATEC|EF[EAFTEGE m@,m YN E |G| A|EAl EGEF| EAFEGF
Ticked : Qléq§QQ

Number of 165] 32| 15[ 70| 81 | 84| 41 | 10 S e8| 99 | e8| 90| re|ry¥| e [ eo

£xds 620168 67143 GA @ GEA Q16 eeiql, 1g°

There were no GA or GEA, and every card

it Pt M = F 520 891 9664 @Ig6a E o1 2iql |

'75.. 6960 R4 goteR ang SI6QIE AUVIER AT

75.  How many delegates were proficient in all AR ?
' 9
z:; fou2r languages vl d
¥
(b) 4 (b)
(i1 (6) ... 8
(d o0 (d o
76.  The number of delegates proficient in both 76‘. Q:le Gegs ausi QRUER QTG & gedue
English and French is : . QSH4l 660 ?
(@ 95 (@ ¢8
(b) 130 A (b) eqmo
(¢) 250 (c) 980

(d) 135 (d ems

ND - 2D/34 (16) (Turnover)
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0

78.

How many are proficient in only two
languages ?

@ 170
(b) 235
(c) 250
(d 19

The number of delegates proﬁcient in only
one language is : :

(@) 453
(b) 137
(c) 200
d 212

(Q79-81) Study the following bar diagram and
answer the questions given below it.

Additional Taxation (Rupees in Crores)

800
700
600 7§
500
400
300
200
100 4

e
79. The increase in additional taxes in 1988-89
as compared to 1984-85 is :
(a) 5.4% :
(b) 4.5%
(c) 95.6%
~(d) 11.2% ;

80. As compared to 1988-89, what was the
percentage of decline in additional taxes in
1990-91 ?

(@ 37.75%
(b) 65.8%
(c) 66.12%
(d 39.8%

81. During which year the percent increase in
additional taxes compared to the previous
year is highest ?

(a) 1987-88

(b) 1988-89

() 1990-91

(d) 1991-92
ND - 2D/34

W

78.

6097 990 QITIER QO Y geRIEa el
6960 ? :

(a €90
(b) 9ms
(c) 980
(d) eco

6Ref 6T QITIER @Eel 89 goRNSa
QY 669 ? :

(a) ¥8M
b)) em®
(© 900
{d)--5e9

(Q79-81) Agade ‘@R Q6 ULR R 4L° F6Q
QURINEYR! 9EIFR A8 TG |

2669 Saqa (6QIF oI16Q)

9¢9

79.

RUrY¥-I8 gaRIea eArr-re 6a 2eas
gQaca 6q60 9F 62108 ? :

(@ 8%¥%

b ¥8%

©) ¢8.9%
)00 ,9%

80.

« 81.

RUrT-r¢ 9RRIER eCLo-CeER 26AS
§QQ6a 60Qel 6Q60 QId 621R8 ?

(@ 99.98%

b) 98.1%
() 99.09%
d <er%

ge o geRiea 6ad od, 26a8 §eaca
§0ae! 98 ATQ c21ad ?
(@ ecro-rr

b)) Rerpene

(17)

(c) ecco-¢e
) ecce-¢9

Contd.
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(Q82-86) The table given below shows the

percentages of the total population of a state by
* - age groups for the year 1991. Study the table and

answer the questions 22 to 26 given below it.

Age Group Percent

Up to 15 30

16 — 25 L7715

26 —35 17.25

36 — 45 14.5

46 — 55 14.25

56 — 65 5.12

66 and above 1.13

Total 100

82.

83.

84.

85.

86.

ND - 2D/34

Which one among the age groups listed-

below accounts for the maximum population
in the state ?

(@) 16-25

(b) 26-35

(c) 36-45

(d) 56-65

Out of every 4200 persons, the number of
persons below 26 years is :

(a) 2005 (approx)

(b) 1760 (approx)

(c) 1910 (approx)

(d) 1890 (approx)

If, there are 200 million people below 36 -

years,how many million people are in the age
group 56-65 (approx) ?

(a) 30.07

CB): = 1575

6c) 12,78

(d) 59.30

[fthere are 10 million people in the age group
56 and above, what is the extent of
difference between the total number of people
in the age group 16-25 and 46-55 ?

(a) 6.8 million (approx)

(b) 5.6 million (approx)

(c)  28.4million (approx)

(d)  34.7 million (approx)

[f the difference between the number of
people in the age groups 46-55 and 26-35 is
11.75 million, then the total population of the
state is :

(a) 400 million (approx)
(b)  391.67 million (approx)
(c) 360 million (approx)
(d) 460 million (approx)

(18)

(Q 82-86) Fe16Q TFUILIQRARI AINETER € ¢
adeIea Q0d AF QAT QINIR 6716 FRA°HYIR
95890 6IKIag | AR 2GR @aG I9° A6
QUAIRYR 22 @ 26 Y§IF0R 28R Qg |

0 Jeus! gesie
€8 adye Mo
9-98 £9.98
99-n8 €9.9%
N9-¥8 RY.8
¥9-88 Y.98
$9-98 $.€9
99 99° QlQ AF6R e.eq
agele €oo

82.

83.

84.

85.

86.

7960 SIReIge @aa od fug cedtea
AIRIQ QSR PRAGI 789 7 |

(@ ¢9-98
(b)) 99-ms
(c) Nno-¥8
d 89-98

go ¥ 900 QPG ARIQ 99 Qdg *F QAAE
Q¢ 6260 QDS ? :

(@) 9ocos (aad)
(b) 990 (aisad)
(c) eceo (aeaid)
(d erco (aisiaid)
9@ M9 odg @F QAR 900 FGE 6RIQ
URQ, QI 626R 89-98 QF QOQ QFQ
6@60 890 6nIQ (IMQIF) 26Q ?

(a) Mo.o9 -

b) es8.98
(c) e9.98
d s¢mqmo

A9 89 Qd @9l 61’ 0IQ ZYS QAAGR € o
G90 6RIQ 28T, 606 €9-98 1° ¥9-88
8 QAAQGR €IS CRINE A°FYI AIIER IRy
6Q60 ? :

(@ o.r 8ge (asad)

(b) 8.9390 (asiad)

(c) 9r.¥age (aald)

d Ny.97ge (asad)

AQ ¥9-88 B 99-N8 oF QUARER 6RIQS

QB FRIGR DR € €.98 BYE, 6662 AR
AP PRAHYI 6Q6E?

(@) Yoo 3ge (aIaid)
(b). Mce.99 dge (aiiad)
() @m0 Fge (asiad)
(d) ¥90 dge (asiad)

(Turnover)
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(Q87-90) The following pie-chart shows the
sources of funds to be collected by the National

Highways Authority of India (NHAI) for its Phase I

projects. Study the pie-chart and answers the
questions 27 to 30 that follow.

Sources of funds to be arranged by NHAI for

Phase II projects (in crores Rs.)

Borrowmg
29952

87. Near about 20% of the funds are to be
arranged through :
(a) SPVS
(b)  External Assistance
(c¢)  Annuity
(d) Market Borrowing

88. If NHAI could receive a total of Rs. 9695
-crores as External Assistance, by what
percent (approximately) should it increase
the Market Borrowing to arrange for the
shortage of funds ?
(@ 4.5%
by 7:5%
(c) 6%
d 8%

89. The central angle correspondmg to Market
Borrowing is :
(a) . 528
(b)) 137.8°
(c) - 187:2°
(d). 192.4°

90. The approximate ratio of the funds to be
arranged through Toll and that through
Market Borrowing is (approximately) :
@ 209
{b) 1:6
(@) 31
28

ND - 2D/34

(Q 87-90) AgAdie ‘AR QI6'6q ANGIL S1E

QU992 GAKAd (49. 9. 1. 2IR)a {1 adiia

gef dial 2IQIg AAIIRgS! AIda g ediaIed |
aIQ-9I¢ 2R @0g 19° 9aed 9427304
aea d2g |

87.

88.

89.

90.

(19)

(4R94IR) qe1a amla ges aIx

aieia eaaIegll aida g (61
: eeIeR)

63624Q A2190!,

SIS 90% TI], 679 LQ 2INA AAUTR ?
(a) adeeq

(b) 63Ide AQLe!
() <gieId
@ <9@ a6

AQ IQYIQEIR § 6J6R9R ALIAG! RUNEA
QIR ¢ 9B 6QIG o FiRaleR, 6069 QIF
Q URAY 98 KA AR Y2l IRIA AP
6@60 9680 (aisaid) 9F @fe ?

(@ ¥.8%

) 9.8%
& 9% g ;
d % .

IRIQ B¢ I20 ANS 6QRIA 6QIE 696S ?
(@ 89°

®) eqmo.r°
() ere.9°
. (d) ey’

66IR FIRIFIEA NS QRIQ Q¢ ARIFER ZUIRIG
AR TR AIFARR AGANS YKL 660 ?
(@ 9:¢ A

(b) e
(c) dmee
d - 9:8

Contd.
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Arithmetic
91.  Evaluate: [(18 - 6) + 4] + [72 - 12 + 3 91.
of 2]
(a) 768
(b)) 572
(c) 275
(d): . 752
92.  Total number of divisors of 10500 except 1 92.
and itself is :
(a) 48
i (b) 46
(c). 42
(d)  None of these
93. What is the least possible number, which 93.
when divided by 2, 3, 4, 5, 6, leaves the ‘
remainders 1, 2, 3, 4, 5, respectively ? '
(@ 60
(b) 61
ai(e): 59
(d 69
94. The fraction equivalent of the recurring 94,
decimal 5. 8737373 ......
173
@ Sy
®) 555
173
€ S
(d) None of these
95. , Which one is highest among‘the following 95.
: 22 4 '
fractions 7:53:5.7?
e
@@ 5
s
G PR
Sl ey 2
4
SR
ND - 2D/34 (20)

S Qe

ISR @0 : [(er — 9) + ¥] + [99 —
R9 +MQ 9]

(@ 991
b) 899
(c) 998
d 989

€ N9° 09 QIQ 66R, Cogooq aqaia
JI919Q JPRR AN 6960 ?

(@ xr
b) ¥
() ¥9

d) - @aeaIe 6F16GE geg

QQ@?J Ay Q‘Gﬂl 6960, AIRIg 9, M, ¥, 8,
96Q 309 QAUNER, AGCH aeliged e, 9,
M, ¥, 8 Q@aI ?

@@ 90
(b) e
() s8¢
d) s¢
ARAIQE QEAR a°ayl 8.romoneq g
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96. In the below given expression, what is the
value of ‘?’

an®*xan'=an’
(@ 229

(b) 275

(c) 425

d 45

97. Number of zeros at the end of the
expression
10+ 100 + 1000 +.......... + 10000000000
is:

@)y« 1

A 10

(c) 55

(d) None of these

98. Find the unit digit of the expression
77 % 88 + 66 x 55 :

@@ 7
(® 6
(© 5
@ 0

99 888 x 888 x 888 - 222 X 222 X 222
© 888X 888 + 888 %X 222 +222%x222  °

(a) 1110
(b) 666
(c) 4
() 16
100. Find the remainder when (1719 x
1721 x 1723 % 1725 x 1727 ) is divided by
18:
(@ 17
(b)) 27
)" 9
(d) .15

101. The average age of Sumit’s family consisting
of 5 members, 3 years ago, was 35 years.
One year ago, a new baby was born .in the
family. Three years hence, the average age
of the family will be :
(a) 36 years

(b) 343 years
) 035 % years
(d) None of these

96.

97

98.

100.

101.

Frea FuIAIQYR ANYT6Q ?” @ MY
6960 ?

(e9)™* x (€9)" = (¢9)"
(@ 9.9¢

(b)) 9.98

() ¥%.98

d x.8

6] 2R 66TER 6REVETIT G4 AZQ ?
QoI RDG RROO0O +iiicivilaassihieinns +
Q00000006000

5 g

() %8

(c) 8%

(d) eueaIs 6RaTT g6

30 2RUBR ¥9R S 6966 Q8 ?
99 X[ + 99 X 88

(@ 9

b) 2

© ¥

@ o
COrXCEEXIrr—999X999X999 _,
COCXTRECRIET X 9984999999

(a) eeeo

(b) 999

© ¥

@d e9-

(R9RC x @99 x ROINX OIS X €999)
@ e QI IS QR VICEEHT 6QR6E AV ?

(@ ¢9

B el
(€): ¢
(d e8

N Q¥ 96 8 Aoy JFe gfiew ARQIeR
2QI2Q 90 N8 9T Al | 6H V6w 1@
gaQIQca @ IR0 94 @g 62IRAN |
0% od Q6q, AAIAR LIRILAR FAA 66V
629 ? |
(@ Toed .

8
o — od
® ™

 GNR
c) TN8—qy
©

. (d)  eceais 6MedE gee
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102. A milkman has 20 litres of milk. He mixes 5
litres of water, which is freely available, in
20 litres of pure milk. If the cost of pure
milk is Rs 18 per litre, then the profit of the
milkman , when he sells all the mixture at
cost price is :
(@ 20%
(b)) 25%
() 5%
(d) 33.33%

103. The incomes of A, B, C are in the ratio
12 : 9 : 7 and their spending are in the ratio
15 : 9 : 8. If A saves 25% of his income,
then, what is the ratio of savings of A, B
and C ?
(&) . Ll 13:+18
(b).  15: 18zl
ko) .16 T 21
(d)=213296.%1

104. Due to fall in mangower the production in a
factory decreases by 60 %. By what percent
should the working hours be increased, to
restore the original production in the
factory ?
(a) 40%
(b) 66.66%
(e} Thalls

(@) 120%

105. A man sells two wrist watches, one at a
profit of 10% and the other at a loss of 10%.
But the selling price of each watch is Rs
200. What is the percentage of profit or loss:?
(@) 1% profit .
(b) 1% loss
() 2% profit
(d) 2% loss

106. Compound and Simple interest on a certain
.sum, at certain rate of interest,after two
years is 220 and 200 respectively. What is
the Principal sum ? :
(@) Rs2,200
(b) Rs 2,000
(c) Rs500
(d) Rs 1,000

107. A is twice as good a workman as B, and
therefore, able to finish a piece of work in
30 days less than B. In how many days, they
can complete the whole work, working
together ?
(a) 30 days
(b) 15 days
(¢) 20 days
(d) 40 days

ND = 2D/34

(22)

102. @66 QUMQQIAIT QlGER 90 GRQQ 19

103.

104.

105.

106.

107.

21 162 90 AR gR F1R6R, 8 AGR AIG
dela Q23, Qg 86 JRIER QaRe | 98
ge F19Q A feq Jal e oFI, I9° 62
d01g fgag |0 JRIea I8 08 6062 oIF
6960 640 AIR 629 ?

(@ 9o0%

b) 98%

(c) 8%

d) mnannx

A,B,C alg 09 : ¢ : QZJQQIG'GQ ag
NQ° GQﬂIQG?Q @ €8 : ¢ : T APUIOER
29190 A Q9IQ 2GR 9‘8% QEQ @ER, 606

- A,Be° C Q QB9Q QUG 6Q6Q 7

(@ ee:em:er
(b) es8:er:ee -
(c) €9:09:9¢
d) Gl S

IR AR 214 64Ig FQHIRIER AR 0%
219 AIRAN | 6963, QAHIRIER @ AYPR
geeelq @89l aIa, QIdY ARE 6960 gose
QR QaIdel ade ?

(a) ¥o%

b) 99.99%
(c) es0%
(d e90%

266 18 a6 21007 38 @98, 6a15N ¢ o%
RANEE IS AMT eo% 8T6R | §g
Q9I8 98 MY 900 67 627 | QIR QI mea
9540 6960 ?

(@ e%ae
(b)) ex%a0
©) 9%
d 9%a0

o od deQ e QI LARERX 4@ e e
Qaea: OGBS R QA QRUFEA 990 IQ°
900 GGl UCT | 606X FIMIQ 660 Ul ?

(@) 99000l

(b) 9ococogwl
() Ssooga@l
(d eooogwl

A, B @99160 gagd an gde 2es 1o
60¢, B 0Ig Mo @0 QF6R N9 Iy 64T
QAQIP A | 6969, AR 6AFI6R IRIO QA
Q08, 6960 @9 IR 62FIER Gal RIF
669 QAAIAER ?

(@ ¢o Q@
(b) ¢8a@
(c) 90 Q@

(d ¥o Qg
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108.

109.

110.
111.
112.

113.

The distance between office and home of
Uma is 80km. One day she was late by
1 hour than the normal time to leave for the
office, so, she increased her speed by 4km/hr.
Thus she reached to office at the normal
time. What is the changed speed of Uma ?

(@) 20km/hr

(b)  16km/hr
(c) 40km/hr
(d)  10km/hr

Between 2’0 clock and 3’0 clock, at what
time , the two hands of a clock coincide ?

(a)2:::104 36
() 2:10:45
(€) 2510 54
(d) 26210 ; 56

Find the cost of carpeting a room, 17m long
and 9 m wide, with a carpet 60cm broad at
40 paisa per metre of length.

(@ Rsl1l0
(b) Rs 102
(¢) Rs 100
(d Rsli2

If the sum of the first 14 terms of an AP is
1050 and its first term is 10, then, find the
20th term from the following ?

@@ 170
(b) 180
© 190
(d 200

Two dice are thrown. What is the probability
that the sum of numbers on the dice is a
prime number ?

@) 1/6
() 12
() 113
@ 512

A truck driver, once in a week, leaves his
house and-drives to the river dock to pick
up supplies. At 6:05 PM, one-fifth of the way
to the dock, he passes the Temple. At 6:15
PM, one-third of the way, he passes the
Dhaba. At what time does he reach the dock ?

(@) 6:50PM

“(b) 6:55PM
.(¢) 7:00PM
(d 7:05PM
ND — 20/34

(23)

108.

109.

110.

111.

112.

113.

Q& EQ’QL NQ° AR ﬂdGQ QI
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(a) @&l go 90 QeRIFR
(b) Q€ go e FeFicR
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66lIGN QIR 9@ K¢l 9RI0 F68 ? j

(@ 9:00:M
(b) 9:00:¥%8
(€) 9:00:8%

d 9:€0:89

9 fica A e ¢ feq oael 88 e
6QI0R16a CIRG! AR 2T | Yo 6A§AR
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6062 AFQIG 6R6E O] HF 629 |

{(a) eRogowl
b) €09 o
(c) eRoogal
(d ee9 eal

49 9@ AFIeQ gea gad e¥T aea 646!
R080 Y QIR JAUF @ Ro UECE | 6069,
AIRTE FRIQ 629G, ¥2 AR JOPR 9 06F
aQ 26e |

(a) €90
() eEv
(€)..  eCo
d) 9oo

o~

ga% peel IF GuIKIRR | PELIYRR Io%EaR
2IQl L°HIGFRR 6QIsl 9@ 661AR Q°CHI 629IR

QAR Q60 ?
(a) ¢/

®) /9

() e/m

d) /9

@Gé] gR LRNA AYIRg &6q AQ AR

P 9NG FAVAQ 6aQUP AT | Q%I 96
8 (R66R, IR dEAIE QICER kR Zore
Qa5 | ARl 96 2869, 1@ QU1AI’dl QICER,
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(@) Q@Y 9 ¢l 8o
(b) a8 9 ¢l 88
(¢) QY 9.00
(d) @4 9.08
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114.

s

116.

1

118.

119

ND - 2D/34

Sami decided to give Kachoris to her friends
on her Birthday. If she gives 3 Kachoris to
each friend, one friend will get only 1
Kachori. Also, if she gives 2 Kachoris to each
friends, she will be left with 13 Kachoris.
How many friends are there ?

@y 12

(b). 1S

(c) 17

d) 16

The calendar for the year 2007 will be the

same for the year :
(a) 2014
(b) 2016
() 201%
(d) 2018

In Roman Number System, there are seven
symbols which are used to represent the
whole number system. The symbols and
their respective values are given below.

=1, V=5, X=10, L=50, C=100, D=500,

M=1000 ; Then, the value of the numeral

MCDLXIV is :
(a) 1666
(b) 664

(c) 1464
d) 656

A +12°+13°+ 4209 =9
@ 2575
(b) 2485
() 2395
@ 2295

The price of 10 chairs is equal to that of 4

tables. The price of 15 chairs and 2 tables-:

together is Rs. 4000. The total price of 12
chairs and 3 tables is :

(@ Rs. 3,500

(b) Rs. 3,750

(c) Rs. 3,840

(d) Rs. 3,900

When Rahul was born, his father was 32
years older than his brother and his mother
was 25 years older than his sister. If Rahul’s
brother is 6 years older than him and his
mother is 3 years younger than his father,
how old was Rahul’s sister when he was
born ?

(@) 7 years

(b) 10 years

(c) 14 years

(d) 19 years

(24)
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(@) 999

b) 99
(c) ¢e¥oy

d) 989
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(@ 9898 Eo)
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(©) 9nes

d 99¢8
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b) @980 ol
(€) wryoow
(d @coo ogl
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120.

{24

122.

123.

124,

ND - 2D/34

A bird shooter was asked how many birds
he had in the bag. He replied that there were
all sparrows but six, all pigeons but six, and
all ducks but six. How many birds he had in
the bag in all ?

(@) 9

(b) 18

(¢} 27

(d) 36

In a family, each daughter has the same
number of brothers as she has sisters and

each son has twice as many sisters as he -

has brothers. How many sons are there in
the family ?

(@ 2
(b):.:3
(c) 4
@ 5
An error 2% in excess is made while
measuring the side of a square. The

percentage of error in the calculated area of
the square is :

@ 2%

(b) 2.02%

(c) 4%

(d) 4.04%

Two pipes A and B can fill a cistern in

37% minutes and 45 minutes respectively.
Both pipes are opened. The cistern will be

- filled in just half an hour, if pipe B is turned

off after :

(@ 5min
(b) 9 min.
(¢) 10 min.
(d 15min. .

A and B entered into partnership with capitals
in the ratio 4 : 5. After 3. months, A

withdrew %th of his capital and B

withdrew —;—th of his capital. The gain at the

end of 10 months was Rs. 760. A’s share in
this profit is :

(a) Rs.330
(b) Rs. 360
(c) Rs.380
(d) Rs.430

(25)
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126.

127.

128.

120

- ND-2D/34

Wwo trains, one from Howrah to Patna and

‘the other from Patna to Howrah, start

simultaneously. After they meet, the trains
reach their destinations after 9 hours and 16
hours respectively. The ratio of their speeds
is:

(a)
(b)
()
(d)

The effective annual rate of interest

O N AN
L A" > . © |

. 16

corresponding to a nominal rate of 6% per

annum payable half-yearly is :

(a) 6.06%

(d) 6.07%

(c) 6.08%

(d 6.09%

The population of a town in the first year
increases by 10%, in the next year it
decreases by 10%. Once again in the third
year it increases by 10% and in the fourth
year it decreases by 10%. If the present

population be 20000, then the population
after four years will be :

(a) 16902
(b) 19602
(c) 20692
(d) None of these

Three unbiased coins are tossed. What is the
probability of getting at most two
heads ? :

(a)
(b)
()

(d)

PN oW A= AW

In 100 m race, A covers the distance .in 36
seconds, B in 45 seconds and C in 48
seconds. If same speed is maintained in a
race of 1600m, B will beat C in the said race
of 1600m by :

(@ 80m
() 75m
(¢) 100m
(d 85m

(26)
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130. A sum of Rs. 10000 is borrowed at 8% per
annum compounded annually, which is paid
back in three equal annual instalments. What

-is the amount of each instalment ?
(a) Rs. 4199.04
(b) Rs. 3880.34
(c) Rs. 3905.06
(d) Rs. 4180.35

131. A trader mixes 26 kg of rice at Rs. 20 per kg
with 30 kg of rice of other variety at Rs. 36
per kg and sells the mixture at
Rs. 30 per kg. His profit percent is :

(@ No profit, no loss
(b) 5%

c) 8%

d 10%

. 132. A man takes twice as long to row & distance
against the stream as to row the same
distance in the direction of the stream. The
ratio of the speed of the boat (in still water)
and the stream is :

475 e g |
(b) 3:1
(c)8:2
d 4:3

133. A scooter has 2 tyres and one Stepney (i.e.
a total of 3 tyres). Each tyre can run up to
a maximum of 5 km. What is the longest

- distance, which can be covered by the
scooter ?
(@ 5km
(B) .5 km
(c) 10km
(d) None of these

134. 150 workers were engaged to finish a piece of
work in a certain number of days. Four
workers dropped on the second day, four more
workers dropped on the third day and 'so on.
It takes 8 more days to finish the work now.
Find the number of days in which the work
was completed.

(@) 20 days

(b) 23 days

(c) 25 days

(d) None of these
ND - 2D/34
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Tea worth Rs. 126 per kg and Rs. 135 per
kg are mixed with a third variety in the ratio
1 : 1 :2.1If the mixture is'worth Rs. 153 per
kg, the price of the third variety per kg will be :

(a) Rs. 169.50

JOBPOI%'SI'ALPOINTS.COM

(b) Rs. 170
(c) Rs. 175.50 -
(d) Rs. 180

Logical Reasoning

(Q136-138)In each of the following questions,

- there are four groups of letters. Three of these are

alike in some way while one is different. Find the

~one which is different.

136. (3) EDCBA

(b) ONMLK

(¢) JIHGF

(d)  XWVuYy
137. ‘(a) AEDCB
(b) GKIJIH

(c) MQPON

(d) PRSTQ
'138. (a) KLLM
(b) TUUW
(c) XYYZ
(d) - OPPQ

(Q139-141)A sales representative plansto visiteach
of six companies M, N, P, Q, R and S exactly once
during the course of one day. She is setting up her
schedule for the day according to the following
conditions.
(I)  She must visit M before N and before
R

(I)  She must visit N before Q.
(III) The third company she vigits must be
P v

139. Which of the following could be the order in
. which sales representative visits the six
companies ?
(@ M,R,N,Q,PS
() M,S,P,N,R,Q
(¢) PR,M,N,Q,S
(d P S,MR,QN
140. Which of the following could be true of the
sales representative’s schedule ?
(@) She visits M third
(b)  She visits R sixth
(¢)  She visits P first :
(d)  She visits Q second :

ND-2D/34 ‘ ‘ (28)
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OFl IR I’ € : € : 9 APAIVER Qo1E
@Qq A8e aIgen faland | 9§ dgaa qay
@eml dal 08 oFl 99, 6069 Qo1a Fana
@6l dal NI 6960 2 ? ;

(@) €9¢.80 ¢Q

(b) €90 ggl

(c) €98.80 g

d) eroegl
9899 o«

(Q 136°138) B3R Q6o 9g6R, 2Faa SIGE
6QlIA1 AT | MAIRE ARIQ FeRIE 6Rlad Q! eled
QUIGAER AFIR 6ARYS 66 63IITN R 266 | 69T
UMGI| AUCE QIAQP 6HIPG |

136. (a) EDCBA

(b) ONMLK
(c) JIHGF
d) Xwvuy
137. (a) AEDCB
(b) GKIJIH
(c) MQPON
(d PRSTQ "
138. (a) KLLM
(b) TUUW
() XYYZ -
(d OPPQ

(Q 139-141) @66 Ig0 AT, 66115~ a1 k68, OF
a6q, 96' atiet M, N, P, Q, R 49° S af@die @aQlg
SdIRR! @Q83 | ATAHE 9@ APAIA! 62 Fee AIR
PeQ QIR I @Qed |
()  6ANgLYR e RgeQMadiade adel
ama?@ 3

(II) QgeQ 6aANg afeds *aQ! LIRgIQ
(Ill) 62 QR RQRYRI QO1G QST
62Q@ P | :

139. Fq@80 qug 62 6af @ celnaica

o~

@3
(@ M,R,N,Q,P,S
() M,S,P,N,R,Q
(©) PRMN,Q,S
(d PS,MRQN
140. SR80 FIQ 6R0C Fga gERNE QIIge
JIA6R AGY 62IRQNER ?
(@) 62 M, @o19 G760 afede @ad
(b) 6aR, 99 F6q fGde 008
(c) 6 gaes P adiade @ad
(d 6QQ, 3010 grca ahede @ad

60QA6a 90 gOFY 826 el adede
?
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141. QG 3Qe 9o geler SAfade 903, 6069

141. Ifthe sales representative visits ‘S’ first, i
which company must she visit second ? OIg Qo106 |FI6Q 6RQ IRg I A6 ?
@ M (@ M
(b) N () N
¢) . c) P
d Q @ Q

(Q142-144)Selectasuitable figure fromtheAnswer ~ (Q 142-144) g4 §2 (?) 9R6Q @8a §8Q 9@

Figures that would replace the question mark (?). QUL 9Q AR @0 | :

142. 142.

Problem Figures : Answer Figures : 4 0@ QA @g :
{300? gaoaoaa EP |l g‘paoaa
A B © ® @OH @ B¢ @ (A) (B)'(€) (D) (1)) ()4

(@ 1 () 1 _
&y 2 (b) 2
(c) 3 () 3
d 4 @

143. 143, =

Problem Figures : Answer Figures : 94 g QAR 9Q !

OO blelolel (BT Bleela

A B © ® O @ 6 @ Ay B) () ) () “ErQ) 4

£ L @ :

(k) 2 by 2

) 3 (o) 3

e e @ 4 1
144. 144.
Problem Figures : Answer Figures : 94 59 : @éQ '59 :
®__[® l :

= ? Ny

B Bl [T Esbl

i (.0 A B © (@D M 2 6 @

@y : ?
(a) 1
by . 2
oo ® 2
(€) 3
d) 4 d 4
145. A,B, C,D andE are five rivers.‘A’ is smaller 145 A, B, C.D, 4%° E Qlsd %‘1 | ‘A%, B’ OI9

than B but longer than ‘E’. “C” is the longest
and ‘D’ is a little smaller than B and a little
longer than A. Find the smallest river.

@ A
) B
() C
d E
ND — 2D/34 (29)

62I6 @g EOIQ @l | ‘C’ 6298 2901 R
9Q° ‘D, ‘B’ OIg §6& 6216 99° A 0IQ §@9
@Al | AQOIQ 6816 AQ1T &9 ?

(@ A
® B
) &
d E

Contd.
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t will come in place of question mark in
the series ? '

150 152 149 .153 148 154 2
(a) 155
(b) 152
(c) 147
(d) 149
(Q147-149)In each question below are given two

statements followed. by two conclusions
numbered I and II. You have to take the given two

statements to be true even if they seem to be at

variance from commonly known facts. Read the

conclusion and then decide which of the given

conclusions logically follows from the two given

statements, disregarding commonly known facts.
Give answer :

(a) If only conclusion I follows
(b) If only conclusion II follows
(c) If neither I nor II follows and
(d) If both I and II follow

147. Statements :
No women teacher can play.
Some women teachers are athletes.
Conclusions :
I Male athletes can play.
11 Some athletes can play.

148. . Statements :
All mangoes.are golden in colour. :
No golden-coloured things are cheap.

- Conclusions :
I . All mangoes are cheap.
II Golden-coloured mangoes are not
cheap. :

149. Statements :
Some kings are queens.
All queens are beautiful.,
Ceonclusions :
I All kings are beautiful,
IT"  All queens are kings.

150. Find the number of friangl_e's in the given

146. 3396a ggo9 296a 9’4 2Ide ?

€80 089 R¥C R8M e¥I egYy I

(@ e8s8
(b) 89
(c) ¢e¥9
(d exc¢

(Q 147-149) 3j6a 89 G6LYL YgeR 26 990
QulaIaE 9° 12 96q 9at dalg QuKIes diel
@ LN [ 64i6R 28 ' 2Iadg QeIQIReel 9aF

G989 20 QI96R goe eaelg
AUV Ralgdl S2uOIQ

Q] A6e 949 |

JRISARP X9° 6l dEQ ARINEGS elIgEl Gelig
Usleasl @ QRIAIQAQI_9at I @IKIQaS)
dRIBFPR AIQ 6260 GIYS QIAER LPIARE 960
0121 98 /ag |

147.

148.

149,

150.

Qae Gag :

(1) 4@ 6aexdRIs 129906 Q6

(b) @9 6er daig II QAR Q66

(©) <@ 13 16x1636 2gard aeq qIF

(d) <% eaa e Il agaed @ad

998 :6ql6d FidqI Fmagt exdaRee GIF |
@8 A8Q! S8ag1 Zlgens 26 |

AR :

I 9 RS F1I6Q 6HRTIRED

II Q8 Zgsns cudalitice

996 : ag 2Ina gt god seiga |
616Q 9ol Qera AW 691 g6d |
dale:

I QQamegl

I g9 eerQ 212 69l g6o

396 : 38 quel quan 268 |
Qg QU gra 263G |

dale

I Ag QIR LA 2SS

I a0g 6len QIe)

R96a QUKL 961, 6R606aIT 0Qe
g ? :

@@ 9
(b) er
() 99
d 99

figure.
) 12
(b) 18
(ch) 22
d) 26
ND - 2D/34

. (30) -
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Space for rough work
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